
 

How To: ADA Compliant Word Documents 

 

Criteria Checklist 

Here is a quick checklist for creating ADA compliant Word documents. You can click on 

each criterion for a more detailed description. Your document must meet all of the 

criteria listed below to be fully ADA compliant. 
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Headers 

Headers are the most important part of a document’s accessibility. While they are useful 

to sighted users, they are essential for those who use assistive technology. Assistive 

technology users will use headers as a table of contents. It will also allow users to jump 

around the document easily, via the navigation pane. While most users can easily skim 

a document, headers give that ability to those using assistive technology. 

Example of Heading Levels: 

To give you a better idea of how headers should be set up, take a look at the image 

below. What you see is a table of contents taken from a book. I have assigned each 

listing a heading. Heading 1 will be the title of you document (this should be your only 

heading 1 in the document). Heading 2 will be the bulk of your primary headings. 

Heading 3 will be assigned to secondary headings, those that belong under your 

heading 2s. In more technical documents, you may also have to use headings 4, 5, and 

6. 

 

  



 

Styles Section: 

In Word, you can find headers in your Styles section. 

 

 

Updating to Match Selection Style: 

The first time you use a heading, you will want to update it to match your font selection. 

For this example, we will be assigning a heading 2. To do this, highlight your heading 

text and then right click the heading 2 choice in your styles tab. From the menu that 

appears, select “Update heading 2 to match selection.” This will make it so that your 

heading 2 will keep the exact same font, size, alignment and any other settings that you 

had attached to the highlighted text. Keep in mind that once you update, this will change 

ALL heading 2s in your document to match the style of the highlighted selection. If you 

want some heading 2s centered and some left aligned, you may have to manually 

change those depending on which heading style you chose to update. 

Note: Heading 3, 4, etc... normally do not appear in the styles section until you have 

assigned a heading 1 and 2. 

 

 

Once you have updated headings to your style choice, you can now highlight your next 

heading text and click your heading level of choice in the styles tab.  

 



 

Navigation Pane: 

Once you have all your headers assigned in your document, you can use the Navigation 

Pane to check if your headers are present and correctly nested. To access the 

navigation pane, click “View” on the tool bar and then click the box next to “Navigation 

Pane.” The pane will pop up in a window on your left. You can see all of your selected 

headings and the nesting for each one. You can click on these headings and it will take 

you to where it is in the document.  

*Note: If you see any blank spots in the navigation list, it means that you have a blank 

line assigned with a heading in your document. Be sure to remove that header by going 

to the blank line in the document and clicking “normal” in the styles tab. I recommend 

always checking Navigation Pane at least once before finishing your file. 

 



 

Alternate Text for Images 

When thinking about good design, visual elements are always a huge factor. This can 

cause issues for those using assistive technology. This is where alternate text, also 

known as “alt text,” comes into play. Alt text is used as a detailed description of an 

image. You want to describe the image as if you were explaining it to a blind person, 

pointing out the important and relevant parts of the image. If you are using an image for 

decoration purpose only and the image has no relevant information, you can use the 

“Mark as Decorative” option. *ALL images should have some form of alt text or is 

marked as decoration. 

Assign Alt Text: 

To assign alt text to an image, right click on the image. In the menu that appears, click 

on “Edit alt text.” Another option is to click on the image, then select the format tab in 

the tool bar and choose “alt text” from the accessibility section. 

 

 



 

Alt Text Panel: 

A panel will appear on the right side of your Word document. This is where you will 

enter your alt text or choose the mark as decorative option. There is also the option 

“Generate a description for me.” I have not had any luck using this feature. If you decide 

to use this, which I do not recommend, be sure to edit any description to fully and 

correctly match your image. 

 

Reminder: Mark as decorative is *ONLY for images that convey no information; Images 

that are only used for a design purpose. If the image has any information that you want 

the students to have, it *MUST have detailed alt text. 

 

Descriptive Hyperlinks 

Those that use assistive technology have the option to view a full list of links available in 

a document. Using descriptive links is important to the user knows where the link is 

taking them and why. You want to avoid putting in a full URL because a screen reader 

will read out the “h t t p : / /” and that can be frustrating to the user. Descriptive 

hyperlinks tell the user what the link is about while also being short and to the point! 

*ALL links must be descriptive hyperlinks with the exception of email links. 

 

Example Hyperlink 

For this example, I want to insert a link to our faculty resource page on the MSUTexas 

website.  

Instead of putting in the URL, which looks like this:  

https://msutexas.edu/distance/online-teaching-aids.php  

I am going to put it as a descriptive hyperlink, which looks like this: 

https://msutexas.edu/distance/online-teaching-aids.php


 

MSUTexas Faculty Resource Page 

This makes it a much shorter link and tells me exactly where I am going. 

Note: Do not use general phrases like “Click here” or “Read More” or “Learn More” as 

your descriptive link. You want the user to know where the link takes them based on the 

description you give it. 

 

Inserting a Descriptive Hyperlink 

To insert a link, you’ll want to type out the description that you want the link attached to. 

Once that is in place, highlight the description and then right click and choose “link” from 

the dropdown menu.  

 

The Insert Hyperlink window will appear. Paste your link into the “address” section and 

then press okay. Your text will now be a descriptive hyperlink, appear blue, and 

underlined. 

 

https://msutexas.edu/distance/online-teaching-aids.php


 

If you already have the hyperlink in the Word document, you can change the text that it 

displayed. Right click your hyperlink and choose “Edit Hyperlink” from the dropdown 

menu. 

 

The Edit Hyperlink window will appear. In the “Text to display” box, put in the description 

for the hyperlink and press okay. 

 

Additional Link Rules 

• Website and email links must lead to the correct, active web destination or 

address. Links need to be corrected if they lead to a dead website, a 404 error, 

or a return to sender email address. 

• All links must be visually distinguishable from the surrounding text. The normal 

blue font with underline works for this criterion.  



 

Lists 

Lists are extremely helpful for those using assistive technology. It gives the user cues 

about the beginning of the list and the movement when going from one list item to 

another. Lists are also extremely valuable for visual learners and great for overall 

design. 

To create a list, highlight the text of choice and choose one of the two list style options 

under the Paragraph section on your toolbar. Once the list is created, you can verify that 

it is a list by clicking anywhere inside of the list and you will see that one of the list styles 

under the Paragraph section will be grayed out. This means that the list is utilizing that 

style. Anywhere you list 4 or more items should be correctly marked as a list. 

 

 

Tables 

Tables can be extremely challenging to assistive technology users if they are not set up 

correctly. *You want to be as simple as possible when creating a table. Tables need 

to include a header row, set up so that the row does not break across pages, have a 

quick alt text, have no merged cells, and have no blank cells unless the table is being 

used for a student to fill the information in themselves. 

  



 

Header Row 

To assign a header row, highlight the row that includes your headings. Right click the 

row and choose “Table Properties” from the dropdown menu. 

 

In the Table Properties window, go to the row tab. In the options section, put a 

checkmark next to “Repeat as header row at the top of each page” then press OK. 

 

  



 

Row Does Not Break Across Page and Alt Text 

To make sure that rows do not break across pages, highlight your entire table, right click 

it and select “Table Properties” from the dropdown menu. 

 

Under the row tab, within the options section, uncheck “Allow row to break across 

pages.” 

 



 

Before you press OK, we can take this time to enter a quick alt text. Go to the Alt Text 

tab and under “Title” put in a short alt text about what the table is for. For example, if 

you are using a table for your course schedule, the alt text can just say “Course 

schedule.” This description does not have to be very detailed. 

 

Merged or Blank Cells 

Merged cells can cause issues for screen readers when it comes to lining up with the 

header row. Below is an example of a merged cell. *Do not use merged cells! 

 

Blank cells also cause issues for screen readers. A blank cell can cause confusion and 

lead to the user losing their place inside of the table. The user would then have to 



 

repeat the table to understand why there was a blank space. You do not want to leave 

any blank spaces. Best practice for a blank cell is to put either “N/A” or another type of 

signifier that tells the screen reader that there is nothing in that cell. The one exception 

where you can use blank cells is if you are creating a table that the student has to fill in 

information themselves. You will want to inform the user right above the table that there 

will be blanks present for them to fill in. Here is an example message: “Certain cells left 

intentionally blank for you to fill in on your own.” 

Color Contrast 

Color can be important to overall design but can cause issues for those with visual 

impairments or those who are colorblind. If you are using color, be sure to pick colors 

with high contrast. The rule to meet WCAG AA standards is a contrast of 4.5:1 for font 

below 18 points and 3:1 for font 18 points and above. *There are ways to check your 

contrast, which I will describe below, but if you want to avoid having to check 

each time then focus on having a light color font on a dark background or a dark 

color font on a light background. The more contrast, the better! 

Checking Contrast 

To check the contrast of a color, you will want to use Deque’s Color Contrast Analyzer. 

This website has three important areas: the foreground color, the background color, and 

the results. 

To change the color of the foreground and background, click on the box below the 

words “Color.” 

 

This will open a small window where you can pick your color. Click on the little dropper 

from the dropdown menu. This will allow you to use the dropper to select the color in 

your Word document. It will give you a magnifying circle that you use to hover over the 

color in your Word doc. You will want to select the darkest color when using the 

dropper. Repeat this for the background color. 

https://dequeuniversity.com/color-contrast


 

 

Once you have selected both your foreground and background colors, you will see the 

results. You goal is to have the ratio be equal to or higher than 4.5:1 if the font is below 

18 points and 3:1 if the font is 18 points or above. In the example below, the color we 

used has a 4.6:1 ratio, which is compliant. Our goal is to meet AA standards. You do 

NOT need to worry about AAA standards. 

Note: The Deque contrast checker works best in Chrome and does not work well in 

Firefox. 

 



 

Emphasized Messages 

If you are trying to portray an important message to your students using Bold, Italic, 

Underline, CAPS, Highlight, or Color screen readers will not pick these up. To help the 

screen reader know that you are giving out important information, put a * in front of the 

message. So now it will be *Bold, *Italic, *Underline, *CAPS, *Highlight, or *Color. It is 

up to your discretion if the message is important enough to earn a * or not. 

Here are a couple examples of sentences: 

• *ALL homework is due by the end of Friday. 

o This sentence seems very important, it should get a * in front of ALL as it 

is underlined and in caps. 

• There will be SOME people who do not want to wake up that early.  

o This sentence is not very important and the word SOME, even though it is 

in caps and bold, was used as a minor emphasis so it does not need a *. 

• Messages in color should almost always have a * with it unless the color is the 

main font of the PowerPoint or document. For example, if I put one sentence in 

red but all my other font is black then it needs a *. If my entire Word font is in a 

dark blue, there is no emphasis to be had so it does not need a *. 

• If you have an entire paragraph that is emphasized, best practice is to put *Note: 

or *Important: at the beginning of the paragraph. 

 

Math Equations 

Math can be extremely difficult for screen reader users, especially if the document is not 

set up with them in mind. The best compliance for math equations will always be the 

built-in math equation tool. 

You can find the equation tool under the Insert tab in the top toolbar under the Symbols 

section. This tool will allow you to build just about any equation and it will read it 

correctly to screen readers. 

 

You can choose a built-in equation or start a new one via the "Insert New Equation." 



 

 

Once you choose an equation you can click anywhere inside the equation. Doing this 

will provide you with a new toolbar that has many more math related options. 



 

 

If you are unable to build your equation with this tool, the backup option is to put the 

equation in as an image and then provide extremely descriptive alt text to the image. 

The alt text you provide should read as if you are verbally saying the equation to 

someone. 

For example: instead of using 3 x 2 in the alt text, you say 3 multiplied by 2. 

 

MathML 

You could look into MathML, which is a mathematical markup language for describing 

notation. The website provided will give you more information and includes tutorials and 

guides. MathML would be a great tool to learn if you use math a lot in your online 

courses. 

 

Language of Parts 

Documents will start with a default language. For most documents the default language 

will be automatically set to English. If you use any other language in your document, it 

must be marked correctly under preferences. This makes it so that a screen reader will 

read the new language in the correct dialect to the user. 

In this example, the second half of this paragraph is in Spanish. Since this is an English 

document I have to set the language preference of the Spanish sentences. 

 

https://developer.mozilla.org/en-US/docs/Web/MathML


 

Select the sentences that are in Spanish. Click on the Review tab in the top toolbar. 

Under the Language section click on Language. In the dropdown menu choose Set 

Proofing Language. 

 

A new language window will appear. From the options choose the correct language. For 

this example, I am picking Spanish (United States). Press Ok once you are finished. 

 

You will repeat this for any other sections where the language changes in your 

document. This must be done for full paragraphs, single sentences, single words, or 

even single letters if they are in a language different from the overall document. 



 

Accessibility Checker 

Word does have an accessibility checker but it is not very accurate when it comes to all 

the compliance requirements. *While I do recommend using it to see if you missed 

something, I would not rely solely on it.  

The accessibility checker can be found under the “Review” section on the top tool bar. 

After selecting “Check Accessibility” your results will show up in a window on the right 

side. Word will inform you of any mistakes it catches and give you information on how to 

correct it. 

 

 

*Note: It is a good habit to check the accessibility checker at least once before you 

finish your file. 



 

 

Document Title and Saving 

Document Title 

Each file must have a descriptive title set in the properties. Document titles allow the 

user to know what the file is going to be about before they open it. If it is opened in a 

browser window, the name of that window will be taken from the document title. This will 

help the student recognize which browser window belongs to the file they just opened. 

To insert a document title, you go to File on the top toolbar. Once this opens, it should 

default to opening the Info tab. If not, click on the Info tab. You will insert a title on the 

right side of this screen, under the properties section, in the title box. Do not forget, this 

needs to be a descriptive title that lets the user know what the file is about based on the 

title you provide. 

  

Here is are some examples of good descriptive document titles for a course syllabus: 

• KNES 9876 Syllabus Fall 2023 

• Fall 2023 KNES 9876 Syllabus 

• Shanks Syllabus Fall 2023 KNES 9876 



 

Saving Your File 

Once you are finished your document as a Word file so that you will have the original 

version in case you need to make any changes. If you would like, you can also save the 

file as a PDF. PDF files are more universal but may lead to additional compliance being 

needed in the PDF file itself.  

To save, go to File -> Save As. Choose your location. First, I save it as a Word file, as it 

is easier to come back and make corrections. If you are wanting to save it as a PDF, 

click the drop down next to “Save as type” and choose PDF. After selecting PDF, click 

into the options menu. Under the include non-printing information section, verify that the 

following options are checked: 

• Create bookmarks using: Headings 

• Document properties 

• Document structure tags for accessibility 

Hit save once finished. Saving this way will also save all compliance.  

*Do NOT save it through the “Print” option as this does not save compliance.  

 

 



 

Additional Assistance 

If you need additional assistance, have ADA related questions, or would like to verify 

that you created an accessible Word document, send an email to 

zack.shanks@msutexas.edu. 

Created By: 

Office of Accessibility and Instructional Design 

Online Education 

Midwestern State University 
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